CUHK ARMO06 Board User Guide

1. Setup RealView Microcontroller Development Kit VV3.03a (Keil uVision3) (Evaluation
version) by running the setup program mdk303a.exe from the disc.

2. Setup Philips Flash Utility by running the Philips Flash Utility Installation.exe program
from the disc.

3. Run Keil uVisinon3 from program list.
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4. Create New Project from Project menu.

Create New Project

BEFMD: |1 ARMdemoDs ~ = @B eF E-
EREFW: | ARMdemals CER,
TFEAEANT): [Project Files (*uv2) ~| HIiH y

5. Select device vendor NXP for our project.



Select Device for Target “Target 1°
CPU ]
Vendor:

Dievvice:
Toolzet:

HEP (founded by Philips)

Data base contents:

+ @ Mentor Graphics Co.
+ % Micronas
+ @ MEIC
+ @: Fwrzomn Technology
+-§® Nordic Semiconductor
- @: MEP (founded by Philips)

£3 807Cs51

£3 80/e7C52

£3 s0csl

£3 socs1xe

£3 a0C3z

£3 s0csae

Description:
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6. Then select device part number LPC2131 for our project and press OK to copy startup
code to project folder.

Select Device for Target "Target 1°

CPU ]

Vendor: NP founded by Philips)

Dewice:  LPCZ2131

Tool=t:  ARM

Diata base contents: Diescription:
£1 LPC3119 s ARMTTDMI-S based hgh-performance 32-bit RISC Microcontraller with
€1 LPC2174 i 32 KB on-chip Flash EOM with Tn-System Programming (T8 and Tn-

Application Programming (TAP), Two 8-ch 10bit ADC
€3 LPC2129 3 KB RAM, Vectored Interrupt Controller,
£3 skl Two TAR Ts, one with full modem intecface.
£ LPC2132 Twro I2C sertal mterfaces, Twao SPT serial mterfaces
= Theee 32-bit imers, Feal Time Clock, Watchdog Timer,
€3 LPC2134 Greneral purpos: [0 ping.
£ LPCal3G CPT clock vp to 60 MHz, On-chip ciovstal oscilator and Cn-chip PLL
£ LPcz2138
€1 LPC2141
£3 LPC2142
£ LPC2144
£3 LPC2146 v
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\.‘_‘p Copy Philips LPC2100 Startop Code to Project Folder and Add File to Project @

Now, your project folder should be like this. The startup code for LPC2131 should be created
automatically

E ARMdemo06 - #Kision3 - [CAARMdemo06\Startup <]

@Eﬂ.e Edit ¥iew Project Debug Flash Peripherals Tools SWCS Window Help _|®: %
AEEg % 58] Q @7 @
£ W K(Target1 Clam=
Praject Wiarkspace & DT o/ttt ook oot ook sk ok ko ook o o s etk ok
. o -
=24 Targetl 002 ./¢ STARTUP.S5: Startup file for Philivs LECEOOD =/
218 Soure Group 1 i1 T T L L Ty R Ty
004 /% 2oo Use Conficuration Wizerd in Context Menu >>> L
1L L T L L L L L L L L E Ty
008  :/# This file is vart of the uVision/ARM develovment tools. =/
007 ./« Copvricht (c) Z005-2006 Keil Software. All riohts reserved. <t
008  /# This software mav onlv be used under the terms of a walid. current. 4
008 /% end wser licence from KEIL for a compatible version of KEIL software 4
010 /% development tools. Nothine else cives vou the richt to use this software. */
L L L L L L T T L T T Y 4
mz
ma
04 s
015 : # The STARTUP.S code is executed after CPU Reset. This file mav be
ME - + translated with the Followine SET svmbols. Tn uVision these SET
g}g r % svmbols are entered under Ovtions - ASM - Define.
.o
08 - « REMAP: when set the startup code initialires the recister MEMMAP
020 - = ppick overwrites the settines of the CPU conficuration vins. The
021 - ¢ startup and interrupt vectors are remavped froms
ez . o# Ax00000000 defanlt settine fnot remapped)
0es . o« xF0000000 when EXTMEM MODE is used
g;g . 2x40000000 when RAM MODE is used
-
026 - ¢ EXTMEM MODE: when set the device is conficured for code executionm
ggg » *  from external memorv starting at address 0x80000000.
. ®
028 . < RAM MODE: when set the device is conficured for code executionm
030 - ¢ fFrom on-chiv RAM startine at address 0x40000000. &
4 3
TextEditur/ﬂ Configuration Wizard f
£ Cﬂl Lot @ Startup.s
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7. Create new blank ARMdemo06.c file from File menu.

BRI D | ARMdemols = £ -

ARMdemo06 Opt

& ARMdemo06 plg

| 3] ARMdemo06 vz
ARMdemolf_Uv2 Bak
Startup .z

@ Teer3mde doc

BREHW: [ARMdemas c

TFBHBRNT): | All Files (% %) | BT




E ARMdemo06 - #Kision3 - [CAARMdemol6iARMdemo06.c]

EJle Edit ¥iew Project Debug Flash Peripherals Tools SWCS Window Help _ = ﬁ
s A B - [ @a] & q & I @
B g K Target 1 S =
Project Wicrkspace = o
=24 Targetl j
=55 Source Group 1
Startup s

Btatups  [E] ARMdemo...

Cutput Window
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Open the ARMdemo06.c file with notepad from ARMdemo06 folder on disc.

P ARMdemol6 ¢ - SEE5H
WEE HEE BHh0 WA KR

7 7 »~
i

i= Demo program for CUHK ARM board 2886

;=

/ i
i= =f
/= ARM CPU: Philips LPC2131

/* Crystal clock: 11.8592 HHz

F= Serial port baudrate: 576088

i= Programming tool: KEIL uUision3 RealUiew for ARH
i=

7 7
#tinclude <lpc21xx._h>

extern void init_timer{void};

ftdefine PWH_FREQ 276808 /7set PUM frequency to 58 Hz

ftdefine L_DIR 8x 006100088 /fset pB.16 as left motor direction

ftdefine L_DIRinu gx 00820000 ffset pB.17 as inverted left motor direction
ftdefine R_DIR 9= 00840000 //set pB.18 as right motor direction

ftdefine R_DIRinv 8= 00080008 /fset pB.19 as inverted right motor direction
f#tdefine TEST_PIHN gx 00810000 Zfset p1.16 as Test pin

ftdefine LWheelSen Bx@80000848 //set pB.6 as left wheel sensor input

ftdefine RWheelSen Ox 00000608 /fset pB.3 as right wheel sensor input

#idefine HEUWLINE sendchar(8x8a); sendchar{8x0d)

//define global variables

£ b




9. Copy the content of ARMdemo06.c on notepad to the blank ARMdemo06.c on uVision3
and save the file.

k/ ARMdemo06 - BKision3 - [CAARMdemo0GAARMdemol6 c*]

@Eﬂz Edit Wiew Project Debug Flash Peripherals Tools 8¥CE Window Help _ |52 X
GEHE BB A e - 1[#h] & @ B[R] ¢ 40 o
w3 &‘Talgetl j &2
Project Wiforkspace x [ili] BT
53 Tarestl 0z e v
5-E5 Souss Gonp 1 ggz j: Dema vrooram for CUHE ARM board 2008 :;
(05 oo
o0g s« 7
007 s« ARM CPU: Philips LEC2131 “Z
oog s« Crvstael clock: 11,0582 MHz “Z
008 se Serial port baudrate: 57600 174
8110 £ Programming taol: KEIL uVisiond RealView For ARM f
G e

D12 kA A

M3 #include <lpc2lxx. h>

m4

015 extern void lnlt_tlmeriveid):

e

017 #define PWM_FRE( 276000 //set PWM freouencv to 50 Hz

me #define L DIR 0x00010000  //set po.16 2s left motor directiom

013 #define L DIRinv 0x00020000  yrset po.17 as inverted laft motor directiom
020 #define B DIR 0«00040000 /5=t bo. 15 as rioht motor direction

021 #define R DIRinv 0<00080000 /5=t po.19 as inverted richt motor direction
022 #define TEST PIN 0x00010000  /rset v1.16 as Test nin

023 #define LWheelSen  Dx00000040 /st po.6 as left wheel sensor invut

024 ddefine RWheelSen  0x00000008  /rset po.5 as sicit wheel seansor input

026 #define NEWLINE sendchar{0xDa); sendchar{0x0d}

028 //define olobal variables
023 long timeval;
030 int lcur, rour, lold, rold, loount, soount;

Startups  [E] ARMdemo...
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10. Open Components, Environment, Books... from Project menu.

V7 ARMdemo06 - Bkision3 - [CARRMdemoDGARMdemol6 c]

@Eﬂz Edit View Project| Debug Flash Peripherals Tools SWCS Window Help — |2 ﬁ
- HWew Project.
fEEg - & @ & 7

Import K Vision] Project.

L Open Project 3
Prajed Workepace Close Project Y
= Targetl Lt
*
52y Soums G]u Components, Envimnment, Banks ram for CURK ARM board 2006 *;
Stary R A R S
*
Remave Group Source Group 1'and its Files Philips LPC2131 Y3
Options for Group Source Group 1' clock: 11.0592 MHz 7
i baudeater BTS00 *
Eno tool: KETL uVisiond RealView for ARM “f
. *
¥

Rebuild all target files

Br{void);
5000 Jiset PEM fremuencv to 50 Hz
00010000 /rse: po.16 as left motor directiom
1 CAARMdemaDfA R Mdemalf Tv2 00020000 /set pd.17 as inverted left motor diraction

. - . 00040000 srset po.is as richt motor direction

021 #define R DIRinv  Dx00030000 /rse: po.19 as inverted rickt motor directionm
022 #define TEST PIN 0x00010000  s/set pi.16 as Test vin

023 ddefine L¥heelSen  Dx00000040  srse: po.6 2s left wheel semsor insat

024 #lefine RWheelSen  0x00000008 ,/set po.3 as richt wheel sensor imput

026 #define NEWLINE sendchar{0x0a); sendchar{0xz0d})
028  //ldefine olopal variables

029 1long tlmeval;
030 int lcur,rcur,lold, rold, lcount, rcount;

5 o
E @ %= Strtups |2 ARMdeno

*|assembling Startup.s... -
linking...
ARMdemo06.axf: Warning: L6665W: Neither LibSSReguestSSarmlib LibSSRequestSScpplib defined, not searching ARM

_§ ARMdema06 . ax Error: L6218E: Undefined symbol _ main (referred from startup.o).

£ ARMdemaoOf.axf: Error: L6Z18E: Undefined symbol _ use two_region memory (referred from startup.a).

B Target not crested -
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Components, Environment and Books

Froject Targets:

Project Components | FoldersExtensions | Books |

W | | Groups: | ¥ | |Files:

X

source Group 1

Zet as Cumrent Target |

4dd Files

e | B | |

11. Add the ARMdemo06.c to the project.

Components, Environment and Books

Project Targets:

Project Components | FolderExtensions | Books |

X ¥ Groups: i A AR
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AR Mdemallf o
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E ARMdemol6 - Bkision3? - [CAARMdemol6lARMdemoD6 ¢]

@Eﬂ.e Edit ¥iew Project Debug Flash Periphersls Tools EVCE Window Help

AEEG = A T T [ & a BE o m

ok ey ,5&|Targel1 j &=
Prajact Workspace x o T e e TR
= E Tagtl - M “ =
S Demo procram for CUHE ARM board 2006 74
=-£3 Source Gooup 1 004 e Py
Startup.s ii: PP P P P T T P PP PP PP PP PR PPy
= ARMdemolt o 00g = =f
Ipe2lsoch 007 = ARM CPU: Philips LPC2131 <
oog s« Crvstal clock: 11.0552 Mz </
003 s« Serial port baudrate: 57600 74
010 s+ Procramming tool: KEIL wuVision3 RealView for ARM 74
i . s
e P
013 #include =<lpc2lux.hos
014
Blg extern void init_timer{void);
017 #define PWM_FREQ 276000 Jiaet PWM frecuepcv to &0 Hz
018 #define L DIR 0:00010000  srset po. 16 25 left motor directiom
019 #define L DIRInv 000020000 srset po,17 as inverted left motor directiom
020 #define R DIR_ 0x00040000 s rset po. 18 as rioht motor direction
021 #define R DIRinv 0x00020000  /yset b, 19 as irverted rickt motor directiom
022 #define TEST_PIN 0x00010000  /ycet pi.16 as Test pin
023 #define LWheelSen  0xD0000040  /rset po.g as left wheel sensor imput
8%; #define RVheelSen  0xD0000008 /rset po.3 as rient wheel semsor invut
026 #define NEWLINE sendchar(0x0a); sendchar{Ox0d)
027
028 /sdefine olobal variables
029 long timeval;
030 int lcur, rcur, lold, rold, lcount, reount;
0N
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12. Open Option for Target ‘Targetl’ and select Output tab. Check the Create HEX file
box.

E ARMdemoD6 - BKision3 - \ARMdemo061ARMdemo06.c]

[E1Fle Edit ¥iew |Broject| Debug Flash Pepipherels Iools VCS Window Help — & ﬁ

g | vt " Y & a oy o |77 @

Import W ¥isionl Project...

@ 1 Open Project =
Praject Workspace Closs Project T
-
= §4 Tergetl x—j
-
=I-E5 Bowrce Gy & Components, Emvironment, Books pram for CUHK ARM board 2004 “

Starty PP R E T PP P PRSP P P TPy

Select Device for Target 'Taxget 1"

ARM %S
Prilips LPC2131 74

‘ Options for Target 'Target 1' clock: 11.05592 MHz =/

prt paudrate: 57600 =/

ing tool: KEIL uVisiond RealView for ARM =F

Build target F7 b

PR P P P ey Yy

Rebuild all tarzet files
@ Translate CALRMdemo0e\AEMdemal6 ¢

Brivoid);
a00o fiset PWM frecsuencv to 50 Hz
00013000 s/set po. 16 as left motor direction
1 CAARMdemo06\L EMdema0s. T3 00020000 ssset bo.17 as inverted left motor direction

- _. - 00040000 /iset v0,28 23 richt mobor directiom

021 #define R _DIRinv 000080000 srset no.19 as inverted richt motor direction
022 #define TEST_PIN 000010000 srzet pi.16 2= Test bvin

023 #define Liheelfen  0x00000040  srset no.6 as left wheel sensor inbut

024 #define RWheelBen  Dx00000002  rrset n0.3 as richt wheel sensor inpuat

026 #define NEWLINE sendchar{0x0a); sendchar{0x0d)

028 s/defipe wlobal variables
029 long tlmeval;
030 4int lcur,rour, lold, rold, loount, rcount;

031

e f
»

Startups  [E] ARMdemo..
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Options for Target ‘Target 1°

| Select Folder for Objects. |

Device | Target Output |Listing | C/C#+ | Asm

%]

| Linksr | Debug | Utilities |

Wame of Executabls: |ERMdemUG

(¢ Create Executable: M\MEMdemo06
[ Debug Information [ Create Batch File
v i

[ Big Endizn

" Create Library: M EMdemola LIB

Before Make:
[~ Run User Program #1: | Browse. ..
[~ Run User Program #2; | Browse...
After Make:
|v Beep When Complete [ Etart Debugging
[ Foun User Program #1: | Biowse...
[~ Run Ueer Program #2: | Browss. .
e | B | Detos | 15

13. Build the HEX file by pressing F7 of by open the Build target from Project menu.

E ARMdemol6 - Bision3 - [CAARMdemol6AARMdemol6 c]

EEﬂe Edit View |Project| Debug Flash Peripherals Tools 3VCE Window Help

New Project...

2@ Y 5 aEE oon e
ﬂ ﬁ Import W Visionl Project.. . {ﬂ @l EIE @ %
@ b Open Project... 1
Project Workspace Close Project P =
= Eﬂ Target 1 ¥4
—-£9 Source G Ii Componsnts, Environment, Books. opram for CUHE ARM board 2006 :;
Starty Select Device for Target ‘Target 1' i AR A A A A AR A A A A A A A A A AR AR A A Ak kS
= & o
Prilips LPCZ131 £f
COrptions for Target Target 1' clock: 11.05852 MH=z EYs
ort baudrate: 57400 =/
Eno tool: KEIL wuVision3 RealView for ARM £f
Bodld target 7 e

R e L P LY

Eebuild all target files
@ Translate C A REMdemo0& W R denno06 ¢

er{void);
4000 Sfset PAM freduencv to 50 HZ
00010800 srset po.16 as left motor directiom
1 CAMEMdemo0oh\A R Mdemo06 Tv2 Q0020000 frset p0.17 as inverted left motor direction
. = - Q0040000 frset po.18 as richt motor directiom
021 #define R_DIRInv 0x00080000  s/set pd.19 as inverted rickt motor directiom
022 #define TERT PIN 0x00010000 ,sset pi.i16 as Test pin
023 #define LWheelZen  0x00000040  srzet p0.6 2z left wheel sensor input
g%é #define RWheelSen  0x00000008 /set p0.3 as richt wheel sensor input
026 #define NEWLINE sendchar({0Ox0a); sendchar({0x0d)
027
028 //defipe olobal variables
029 Jlong tlmeval;
030 dint lcur,rcur,lold, rold, lcount, rcount;
031
nw o =
AR »

Startup s ARMdemo...

assembling Startup.s...
compiling ARMdemol6.c. ..
é linking...
£ FromELF: creating hex file...
5
[=8

"ARMdemo06.axzf"

] EIET I

- 0 Error(s), 0 Warning(s).

[\Build/{‘ Command }\' Find in Files lfr

L:26 C:47

UM




14. Open Configure Flash Tools... from Flash menu. Then set the Command point to Philips
Flash Utility program LPC210X_ISP.exe and set the BAUD rate of COM1 in Arguments
box to 57600.

E ARMdemoD6 - Bkision? RMdemol6iARMdemol6 c]

@Eﬂ.e Edit View Project Debug Flash| Peripherals Tools EVCE Window Help

S o nioad
fEdg ¥ D @m[ eal# & @ [@BE o el m
& [ 5 AX|Targel =
Project Workspace [ Y. - - < - v v vk it £t i A R Rk A AR A AR AR R A AR
-
= 5 Targetl R e ';
* n for CUHKE ARM board ZOO6 *
= E Source Glﬂll]]l 04 o emo prooramn or oar By
005 sttt ittt A A A AR A AR A AR AR A AR AR A A A AR AR AR A AR AR A A A AR AR AR AR A
= ooE /= Y
[ lpc2taoch 0z e ARM CPU: Philivs LPC2131 </
g s« Crvstal clock: 11.0552 MHz =/
003 s« Serial port baudrate: 57600 4
g}? (i Programmine tool: KEIL uVisiond RealView for ARM £
£* 4

Ly L L T4

013 #include <lpcdlsxx kb=

014

015 extern void init_timer{veid);

016

017 #define PWM_FREQ 274000 //set PWM frecuencv to 50 Hz

M8 #define L _DIR 0x00010000  s/set po.16 as left motor direction

18 #define L_DIRinv 0x00020000  srset p0.17 as inverted left moteor direction
020 #define R_DIR 0:00040000  srset p0.28 as rickt moter directionm

021 #define R DIRInv 0x00080000  s/set no.19 as inverted richt motor directiom
022 #define TEST_FIN 0x00010000  s/set pi.id as Test pim

023 #define LWheelfen  0x00000040  srset no.6 as left whesl sensor inmbut

ggg #define RWheelSen  0x00000008  srset wo.5 as rieht wheel sensor input

026 #define WEWLINE sendchar(0x0a); sendchari0z0d)

027

028 //defipe olobal variables

029 long timeval;

030 int lcur,rcur, lold, rold, lcount, rcount;

ﬁi; i ’_I'
| S| % Strtups  [2] ARMemo..

Bl Fuild target 'Target 1'
assembling Startup.s...
compiling ARMdemo06.c. ..

é linking...

£ FromELF: creating hex file...

S| "ARMdemc06 ., axf" - 0 Error(s), 0 Warning(s). -
2

3‘ | | | I\Buildj{ Comrand )\ Find in Files f || 1 | 3 ’_‘
Configure Flach Tool: Simlation L:26 C:A7 NUM RiW

Options for Target ‘Target 1° [')_(

Device | Target | Output | Listing | C/C++ | Asm | Linker | Debug  Utilities |
Configure Flazh Menn Conumand
(" Use Target Diriver for Flash Frogramming

| = r
Init File: J
(# sz External Tool for Flash Programming

Command - |E:'\.P1'Dgram Files\Philips Sevdcond vetors\Philips Flash ThlipALPC210x_I5F exe
Arguments: |#H A $D COM1: 57600 1

[~ Eun Independent

HETE | B Defanlts S7EH




15. Connect the ARMO6 board to power supply and connect to COML1 port. Set the jumper of
P0.14 and turn on the power supply.

16. Download the HEX file by opening the Download from Flash menu. The Flash Utility
will start automatically and the HEX file will be downloaded to the LPC2131 MCU.

K#| ARMdemo06

#Kision3 - [C:AARMdemoD6iARMdemoD6.c]

Bl Eil: Edit Fiew

Project Debuog |Flash| Pepipherals Tools SVCS Window Help

|88 Downlod A ~ (a4 #4 g @ B o e o

=l=| |

LT
& #4 A\|Targel ]
Project Workspace = || Configure Flash Tools [k k kA A A AR AR AR AR AR R AR AR AA AR R AR AR AR AR AR R R ]
-
=59 Targetl UDUEIZB /; & *;
= = Demo prooram for CURK ARM board 2006 *
£ Bource Group 1 o e .
DO o kbbb ok oo A
= g s« s f
[ Ipe2lmeh 07 s ARM CPU: Prilivs LPCZ131 2/
oog s Crvstal clock: 11.0592 MHz #f
s se Serial port baudrate: 57600 =/
g}? £ Programmine tool: KEIL uVision3 RealView Ffor ARM =/
s* Y
D12 /bt 6 6 6
013 #include «lpc2lzx he
014
015 extern void init_timer{voia);
016
017 #define PUM_FREQ 274000 /iset PHM frecuencv to 50 Hz
me #define L_DIR 0x00010000  //sst p0.16 as left motor directiom
019 #define L DIRInw 0200020000 //set no.27 a5 inverted left motor directiom
020 #define R DIR 0200040000 s /set po.25 as rickt motor directiom

021 #define R DIRinv 0200080000 //set p0,25 as invertsd rioht motor directiocm
022 #define TEST_PIN 0x00010000  //set pi.16 as Test bin

023 #define LWheelfen  0:00000040  r/se: no.6 as left wheel sensor input

024 #define R¥heelZen  0x00000008 //sst 20,3 as rieht wheel senser invut

026 #define NEWLINE sendchar{0x0a}; sendcharf Dx0d)]
028 /rdefine olobal variables

029 loneg tlmeval;
030 int lcur,rcur,lold, rold, lcount, roount;

o

I LI

LR Strps ) ARMdemo

*|linking...

FremELF: creating hex file...
"ARMdemoO&.axf" - 0 Erroris)., 0 Warning(s).

[=|

§ "E:“Program Files“FPhilips Semiconductors>~Philips Flash Utility~LPCZ10z_ISF.exe" "C:“ARMdemcO6~ARMdemalf .HEX"
é “Program Files»Philips Semiconductors>Philips Flash Utility~LPC210xz_ISP.exe" "C:“ARMdemoO6~ARMdemo06 HEX"
5 “Program Files Philips SemiconductorssPhilips Flash Utility~LPC210x_I3SP.exe" "C:“ARMdemoO&6~ARMdemol& HEX"
a

2 AT T 1 Build £ Command } Findin Files K

Download to Flash Memory Smmulaton L26CAa7 NOM

- - P E  — TR = R -
- [fagen lawm
[ Project workspace * [ 2
=1 E Targetl i
=5 Souse Grovp 1

‘af= VLIS Stwtws B ARMdema

Startup 5

ARMdemolGic | T
e E]]]I

Flash Programming

v V2.2.3

Communication

xos Semicon
Q\:\\\\ps dqu(b;p

Connected To Port:

C\ARMdemalGhAR b COM1 -
ot Use Baud Rt
52 Baud Rale:
Uplosd to Flash . — || [57em0 -
LPC2000 Flash Utility L
Compare Flash @m'lil\'; ’w'_imﬂ;'zﬂ;lm TineOut sect | 5
ersion 2.2.
Device- 1 Us=DTRATS
Device: = for Reset and
[CEER— = Pai 0] F Boot Loate
KTALFieq M [zoo0 Device ID e Selection

i ]

x

linking. .. 4|

|FromELF: creating hex file...

“ARMdemo06 .axf" - 0 Error(s), 0 Warning(s).
“Frogram Files“Philips Semiconductors“Philips Flash Utility“LPC210z_ISP.exe" "C:“ARMdemoD6“ARMdemo06 . HEX"

"E:NProgram Files“Philips Semiconductors“Philips Flash Utility~LPC210z ISP.exe" "C:“ARMdemoO&“ARMdemoOg .HEX" "

| utput Window

“Program Files Philips Semiconductors Philips Flash Utility~LPC210x_ISP.exe" "C: \ARMdemoO6 ARMdema0s HEX"
»

AT Build £ Command J Find in Files 1|«



17. Open the Hyper Terminal and set the baud rate to 57600.

“g 57600 - BB ERE

HEER EHE WA i @R SHE
A
v
< >
dEiR 00046 BHEnEEl | BEnEE NI

18. Open the jumper on the ARMO6 board and press the Reset switch the demo program will
be executed on the ARMO6 board.

“g 57600 - BRFERREE

BEE REE WRO E0 S§ED e

0O = & DBy
* CUHK Computer Science and Engineering Department *
= LPC2131 ARM Board (2086) =
= f - forward 100 steps (723cm}; b - backward 100 steps (723cm) »*
= [ - continue forward; B - continue backward *
= s - stop; p - show sensor values (Unit:0.1mY) =
* 7 - decrease speed; ¥ - increase speed =
Front = 18414; Left = 18348; Right = 21054

Back Left = 16137; Back Right = 19536
¢ | > .
SR 00136 | EENEE | 57600 8-N-1 NUM

END



